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INTRODUCTION TO HYDROLOGIC  
MODELING USING HEC-HMS 
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SEMINAR OUTLINE 
 

• Overview of hydrologic modeling using HEC-HMS 

• HEC-HMS technical capabilities 

• Components of a HEC-HMS hydrologic model 

• Introduction to HEC-HMS 

• HEC-HMS example problems 
– Group example (simple detention) 

– Individual examples (complex detention) 
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HYDROLOGIC  MODELING  OVERVIEW  

A.  Recent History (State-of-the-Practice) 

1. DOS based - batch data models (before 1990)  

2. Pre- and post processors (1990-1995) 

3. Windows pre- and post-processors (1993-1997) 

4. Windows GUI models (present) 

5. GIS based models (present and future) 
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HEC-1 IN DOS 
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HEC-HMS IN WINDOWS 
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HEC-HMS WEBSITE  

• The latest version of HEC-HMS is available for 
download at the following website: 

http://www.hec.usace.army.mil/software/hec-hms/ 

 

• Additional information available on website: 
• Quick Start Guide 

• User’s Manual 

• Technical Reference Manual 

• Release notes 
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TECHNICAL  CAPABILITIES  

Precipitation 

 gaged storms 

 

 design  storms 

• lumped (precipitation and losses spatially 
averaged over the subbasin), or  

• linear-distributed (precipitation and losses 
specified for grid cells for radar R/F data) 
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Rainfall Losses (abstractions) 

• initial/constant 

• SCS curve number 

• SMA (5 layer) 

• deficit/constant rate (DC) and gridded DC 

• Green and Ampt  

• exponential 

• gridded SCS & SMA 

TECHNICAL  CAPABILITIES  
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    Runoff Transformation 

• unit hydrograph (user specified UH or S-graph, 
Clark, Snyder, or SCS methods) 

• modified Clark (for gridded meteorological data)  

• kinematic wave (up to 2 overland flow planes, 2 
collector channels, and a main channel) 

time 

Q 

TECHNICAL  CAPABILITIES  
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Hydrologic modeling in the WMO must use the SCS unit hydrograph 
(shown below).  

 

 

 

 

 

 

 

 

The rainfall hyetograph is used with the unit hydrograph to develop 
the storm hydrograph using hydrograph convolution. 

 

SCS UNIT HYDROGRAPH 
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TECHNICAL  CAPABILITIES  

Routing (channel) 

• simple lag  

• straddle-stagger 

• modified Puls  

• kinematic wave 

 

 Muskingum 

 Muskingum-Cunge 
(standard shapes) 

 Muskingum-Cunge (8 pt.) 
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Channel Routing 
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Trib Area = 110 acres, Routing using Muskingum Cunge 
L = 3200 ft, S = 0.009, n =  0.08, Trapezoid with W = 60’ and 2H:1V 



RESERVOIR  ROUTING 
CAPABILITIES 

• Attenuation of a hydrograph from any storage element 
(ponds, wetlands, infiltration devices) 

• Outflow calculations from either 1) user supplied 
storage-outflow, elev-storage-outflow, or elev-area-
outflow; or 2) user supplied elev-storage or elev-area 
and defined outlet structures (up to 10 spillways and 
10 outlets). Note: Spillway outfow can also be 
determined from user supplied elev-discharge data.  
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RESERVOIR  ROUTING 
CAPABILITIES 

(cont.) 
• Outlets can be orifices or culverts (up to 9 shapes from 

FHWA design charts which will compute outlet control) 

• Backwater Effects (constant or elev-discharge) 

• Dam Break and Pump Capabilities 

• Reservoir Dam Seepage  
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RESERVOIR  ROUTING  METHOD   
Modified Puls Routing ==> Limitations: 

• No rule-operational gates allowed 

• Monotonically Increasing Relationship 
Between Storage and Outflow 

• No ponds in series (unless constant tailwater) 
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I – O = ΔS                                                             
  Δt 

Where:   I = inflow; O = outflow; S = storage; and t = time interval  

I(Δt) – O(Δt) = ΔS 

 

If t1 and t2 are used to indicate time t and Δt 

 

 

Rearranging knowns and unknowns yields: 

(I1 +  I2) Δt - (O1 + O2) Δt = S2 – S1 

2 2 

(I1 + I2) Δt + S1 - O1 Δt = S2 + O2 Δt 

2 2 2 

METHODOLOGY USED BY HEC-HMS 
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• The procedure used to solve this equation is known 
as the storage indication method or Modified-Puls 
method.  We know the inflows at all times, the 
initial storage S1 and the initial outflow O1.  After 
solving for S2 and O2 these become the inputs for 
the next time step.  The solution procedure uses 
curves of 

 

 

 

 

 

 

METHODOLOGY USED BY HEC-HMS 

S + O2 Δt as shown on the next slide: 

2 
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METHODOLOGY USED BY HEC-HMS 
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• The routing of the hydrographs through the facility 
procedure shown in Tabular form: 

 

METHODOLOGY USED BY HEC-HMS 
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• The inflow and outflow hydrographs computed by 
HEC-HMS are shown graphically 

 

 

METHODOLOGY USED BY HEC-HMS 
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 What model parameters would you change if... 

time 

Q 

measured 

modeled 

time 

Q 

CALIBRATION & VALIDATION 



TECHNICAL  CAPABILITIES  

Additional Capabilities 
• diversions and sinks 
• base flow and pumps 
• GIS connection 
• evapotranspiration 
• snowfall/snow melt 
• reservoir routing (w/tailwater) and dam breach 
• parameter optimization 
• hot start – use data from end of previous run 
• land surface erosion and sediment transport* 
• customizable graphs and reports* 
     * future versions 
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HEC-HMS  MODEL  STRUCTURE 

Project Requirements 

(Operational and  

Data Structure) 

Meteorological 

Model 

(precipitation, snowmelt, 

 and evapotranspiration) 

Basin Model 

(hydrologic elements 

 are interconnected to 

represent watershed) 

Control 

Specifications 

(start time, end time, 

and time interval) 

Time Series Data 

(e.g., precipitation) 

Paired Data 

(e.g., reservoir data) 
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HEC-HMS MODEL COMPONENTS 

• Basin Model 
– Physical components of a watershed (subbasins, reservoirs, reaches, etc.) 
 

• Meteorologic Model 
– Specify precipitation events to be simulated by the hydrologic model 

– Can include snowmelt and evapotranspiration 
 

• Control Specifications 
– Start time, end time, and time interval 
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*You need all 3 components to complete a successful simulation in HEC-HMS 



INPUT  DATA  COMPONENTS 

Time Series Data 

 Precipitation gages 

 Discharge gages 

 Stage gages 

 Temperature gages 

 Etc. 

Paired Data 

 Storage-discharge 

 Elevation-storage 

 Inflow-diversion 

 Cross sections 

 Etc. 
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WORKING  WITH  HEC-HMS 

Application Steps 
• create a new project 
• enter Basin Model data 
• enter time series & paired 

data   
• enter Met. Model data 
• enter Control Specifications 
• create and execute a run 
• view results (global and 

element summary tables, time 
series tables and graphs, and 
results from multiple elements 
and multiple runs)  

• exit program 
time 

Q 
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USER   

INTERFACE 

DESKTOP 

MESSAGE LOG 

COMPONENT 
EDITOR 

WATERSHED 
EXPLORER 
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EXAMPLE PROBLEM #1 (GROUP) 
Goal of Example:  

• Enter Input Data 
– Subbasin Information 

– Rainfall Data 

– Reservoir (Detention) Information 

• Run HEC-HMS 
– 100-Year, 24-Hour Storm Event 

– Additional Storm Events 

• View Output and Results 
– Tabular Output 

– Flow and Stage Hydrographs 
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EXAMPLE PROBLEM #1 (GROUP) 
Given the following information, determine the required 
detention volume based on the WMO. 
 

Site Information:  

• Site Area = 5 acres 

• CN = 93, Proposed Site is 80% Impervious 

• Tc = 15 minutes, SCS Lag Time = 9 minutes 

• Assume no unrestricted releases from the site 
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EXAMPLE 1 – STEP 1 

30 

 

Step 1: Determine the required volume control storage 
for the site. 
 

The curve number for the site is 93, with a total 
impervious area of 4 acres (80%). The required volume 
control storage, Vc, for the site is calculated as: 
 

 

 

Vc = 1” x 
1 foot 

  x 4 acres = 0.33 acre-feet 
12 inches 



EXAMPLE 1 – STEP 2 
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Step 2: Determine the CN reduction corresponding to 
volume control calculated in Step 1. 
 

 
 

 

Using the CN Adjustment 
Calculator spreadsheet, the 
adjusted curve number is 
86.22 (it was assumed that 
only the required 1” of 
volume control storage 
would be provided). 
 

RUNOFF CURVE NUMBER ADJUSTMENT CALCULATOR

Site Information:

Total Site Area, Aw (ac) = 5 Total Impervious Area, AI (ac) = 4

Runoff, R (in) = 6.75

P = rainfall depth (in) = 7.58

CN = 93

S = 0.75

Runoff Volume Over Watershed, Vw (ac-ft) =            2.81

Control Volume, VR  = 0.33 ac-ft 1" of volume over impervious area

Additional Volume, VGI  = 0.00 ac-ft Additional volume over the required 1"

Adjusted Volume Over Watershed, VADJ = VW - VR - VGI

VADJ (ac-ft) = 2.48

Adjusted Runoff Over Watershed, RADJ = VADJ

                                                                                     AW

RADJ (in) = 5.95

SADJ= 1.60

Adjusted CN for detention calcs, CNADJ = 86.22

*Blue values are entered by user

Volume of GI Provided:



EXAMPLE 1 – STEP 3 
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Step 3: Determine the allowable release rate from the site. 
 

Maximum allowable release rate = 0.30 cfs/acre x 5 acres = 1.50 cfs 

 

Maximum allowable release rate – unrestricted release rate = net allowable release rate 

 

The net allowable release rate = 1.50 cfs – 0.00 cfs = 1.50 cfs 
 



GETTING STARTED  
THE INITIAL HEC-HMS SCREEN 

● Double-click on the HEC-HMS 
icon on your desktop 

 

 

 

● The following HEC-HMS 
Screen comes up:  
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HEC-HMS – SETTING UP A NEW PROJECT 

● Click on the “File” 
menu 
 

● From the drop 
down menu, select 
“New” 

 
● Name the new 

project “Example 1” 
 

● Be sure to set the 
Default Unit System 
to “U.S. Customary” 
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SETTING UP PROJECT DEFAULTS 
● Under the Tools Menu, 

go to Program Settings 
and go to the Defaults 
tab 

● Specify SCS Curve 
Number for Subbasin 
loss, SCS Unit 
Hydrograph for Subbasin 
transform, Modified Puls 
for Reach routing, and 
Specified Hyetograph for 
Subbasin precipitation 

● Then go to the Results 
tab and make sure that 
the values for elevation, 
volume, flowrate, and 
depth are taken to 2 
decimal places. 
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CREATING A BASIN MODEL 
● Under the Components 

tab, go to Basin Model 
Manager 

 

● Select “New” and name 
it “Basin 1” 
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ADDING BASIN MODEL COMPONENTS 
● Click on the Subbasin 

Creation Tool at the top 
of the screen to add a 
subbasin to the Basin 
Model 

 
● Click on the Reservoir 

Creation Tool to add a 
reservoir to the Basin 
Model 

 
● To route the subbasin 

through the reservoir, 
right-click on the 
subbasin and select 
“Connect Downstream” 
and click on the reservoir 
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ENTERING SUBBASIN DATA 
● Click on Subbasin-1 and 

the data entry tabs will 
appear at the lower left 
corner 

 

● For Area, enter 
0.0078125 mi2 (5 acres) 

 

● Under the Loss tab, enter 
the reduced CN of 86.22 

 

● Under the Transform tab, 
enter the SCS Lag time of 
9 minutes  

      (Lag time = 0.6 * Tc) 
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ENTERING RESERVOIR DATA 
● Click on Reservoir-1 and 

the data entry tabs will 
appear at the lower left 
corner 

 
● For Method, enter 

Outflow Curve 
 
● For Storage Method, 

select Elevation-Storage-
Discharge 

 
● Note that the Storage-

Discharge and Elevation-
Storage Functions are 
missing. This is the next 
step. 
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ENTERING RESERVOIR DATA 
● Using the spreadsheet available on the MWRD website, the 

following stage-discharge relationship was determined for the 
proposed detention basin: 
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Stage  
(ft) 

Discharge 
 (cfs) 

600 0.00 

601 0.61 

602 0.92 

603 1.15 

604 1.34 

605 1.50 

PROPOSED CONDITIONS

ORIFICE/WEIR STRUCTURE RATING ANALYSIS

PROJECT NAME: Example 1

PROJ. NO.: WMO Training

DESCRIPTION: Detention Basin 1

FILENAME: Orifice.xlsx

DATE: 31-Jul-14

OUTLET: ORIFICE: 5.07  IN. DIA. @ ELEV 600

WEIR: 12  FEET WIDE  @  ELEV605

ORIFICE FLOW EQUATION:  Q = CdA(2gH)0.5

WEIR FLOW EQUATION:  Q = 3.0L(H)1.5

HYDRAULIC DIMENSIONS

# 1

ORIFICE AREA (ft
2
) 0.1402

ORIFICE DIAMETER (in) 5.07

ORIFICE DISCHARGE COEFFICIENT 0.61

ORIFICE ELEV. (ft-NAVD88) 600.00

TAILWATER OR CENTROID (ft-NAVD88) 600.211

WEIR LENGTH (ft) 12.00

WEIR COEFFICIENT 3.0

WEIR ELEV. (ft-NAVD88) 605.0

ELEVATION-DISCHARGE RELATIONSHIP

Elevation Q-Orifice Q-Weir Q-Total

(feet) (cfs) (cfs) (cfs)

600.0 0.00 0.00 0.00

600.5 0.37 0.00 0.37

601.0 0.61 0.00 0.61

601.5 0.78 0.00 0.78

602.0 0.92 0.00 0.92

602.5 1.04 0.00 1.04

603.0 1.15 0.00 1.15

603.5 1.24 0.00 1.24

604.0 1.34 0.00 1.34

604.5 1.42 0.00 1.42

605.0 1.50 0.00 1.50

605.5 1.58 12.73 14.31

606.0 1.65 36.00 37.65

599.0

600.0

601.0

602.0

603.0

604.0

605.0

606.0

0.0 0.2 0.4 0.6 0.8 1.0 1.2 1.4 1.6

E
L
E

V
A

T
IO

N
 
(f
t-

N
A

V
D

8
8
)

DISCHARGE (cfs)

ORIFICE RATING CURVE



ENTERING RESERVOIR DATA 
● Using the spreadsheet available on the MWRD website, the 

following stage-storage relationship was determined for the 
proposed detention basin: 
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Stage  
(ft) 

Storage 
 (ac-ft) 

600 0.00 

601 0.14 

602 0.32 

603 0.52 

604 0.76 

605 1.04 

POND: Pond 1

JOB NO. TGM Side Slopes

PROJECT: Example 1 1

FILE: Storage.xls 4

DATE: 8/4/2014

Area Average Incremental Cummulative 

Elevation Area Storage Storage

(ft) (ft
2
) (ac) (ac) (ac-ft) (ac-ft)

600.00 5,539 0.127 0.000

0.142 0.14

601.00 6,794 0.156 0.14

0.174 0.17

602.00 8,400 0.193 0.32

0.205 0.21

603.00 9,500 0.218 0.52

0.237 0.24

604.00 11,123 0.255 0.76

0.278 0.28

605.00 13,100 0.301 1.04

Elevation Storage

 (ft, NAVD88)  (ac-ft)

600.00 0.000

601.00 0.14

602.00 0.32

603.00 0.52

604.00 0.76

605.00 1.04

0.0

0.2

0.4

0.6

0.8

1.0

1.2

600.0 600.5 601.0 601.5 602.0 602.5 603.0 603.5 604.0 604.5 605.0

S
T
O

R
A

G
E

 
(A

C
R

E
-F

E
E

T
)

ELEVATION (FT, NAVD88)

ELEVATION - STORAGE CURVE



ENTERING RESERVOIR DATA 
● Under the Components 

tab, select Paired Data 
Manager 

 
● Add a new Storage-

Discharge and Elevation-
Storage function. Name 
each of them “Pond 1” 

 
● Under the Table tab, 

enter the appropriate 
elevation, storage, and 
discharge values 

 
● Plots of the relationships 

are available under the 
Graph tab 
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ENTERING RESERVOIR DATA 
● The last step is assigning 

the Paired Data to 
Reservoir-1 

 
● For the Stor-Dis Function, 

select the Paired Data 
from the drop-down menu 

 
● For the Elev-Stor Function, 

select the Paired Data 
from the drop-down menu 

 
● For Primary, select 

Storage-Discharge 
 
● For Initial Condition, select 

Inflow = Outflow 
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ENTERING RAINFALL DATA 
● In HEC-HMS, rainfall data is entered as a combination of Time-Series 

Data and the Meteorologic Model 

 

● The Time-Series Data reflects the rainfall distribution (Huff quartile 
distributions or actual rainfall records) 

 

● Time-Series Data cannot be entered in user-specified increments, 
interpolation of points on the Huff curves may be necessary for some 
storm events 

 

● The Meteorologic Model defines the rainfall depths and which 
subbasins those depths are applied  
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ENTERING TIME-SERIES DATA 
● From the Components 

menu, select Time-Series 
Data Manager to create a 
new Precipitation Gage 
named “Huff3rd24hr” 

 
● Under the Time-Series Gage 

tab, select Manual Entry, 
Cumulative Inches, and 1-
hour increments 

 
● Under the Time Window 

tab, run the storm from 
01Jan2000 through 
02Jan2000 (24-hour 
duration) 

 
● Enter the Huff 3rd Quartile 

Distribution for the 24-hour 
duration from the handout 

 
● Use the Graph tab to see a 

plot of the distribution 
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CREATING THE METEOROLOGIC MODEL 
● From the Components tab, 

create a new Meteorologic 
Model named “100yr24hr” 
 

● Under the Meteorology 
Model tab, make sure the 
Replace Missing is Set to 
Default 

 
● Under the Basins tab, select 

Yes under Include 
Subbasins? 
 

● Under the Options tab, 
select Yes for Total Override 

 
● Under the Specified 

Hyetograph tab, select the 
rainfall distribution that we 
previously created and enter 
the 100-year, 24-hour 
rainfall depth. 
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CREATING THE CONTROL SPECIFICATIONS 
● We still need the specify 

how long to run the model 
for and how often we want 
to see output...this is 
performed under the 
Control Specifications 

 
● Under the Components 

menu, select Control 
Specifications Manager to 
create a new one named 
“100yr24hr” 
 

● Specify 01Jan2000 through 
03Jan2000 (remember 
we’re running a 24-hour 
storm event) 

 
● Under Time Interval, 

specify 1 minute 
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CREATING THE SIMULATION RUN 
● A Simulation Run is a 

combination of: 
● Basin Model 
● Meteorologic Model 
● Control Specifications 

 
● To create a new Simulation 

Run, select Create 
Compute > Simulation Run 
under the Components 
menu 
 

● Name the run “100yr24hr” 
and click Next 

 
● Specify the Basin Model, 

Meteorologic Model, and 
Control Specifications that 
we’ve just created 
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RUNNING THE SIMULATION 
● Under the Compute 

menu, select Compute 
Run [100yr24hr] 

 

● All errors, warnings, and 
notes are shown in the 
lower right hand 
window 

 

● If there are errors, they 
will show up in red and 
the simulation will not 
run successfully 
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VIEWING RESULTS 
● If the Simulation Run 

was successful, right-
click on the components 
of the Basin Model to 
view individual results 

 

● Results are available as a 
Graph, Summary Table, 
or Time-Series Table 

 

● To view the results for 
all model components at 
once, choose Global 
Summary Table under 
the Results Menu 
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EXAMPLE 1 RESULTS 

• What is the peak elevation in the proposed detention 
basin  for the 100-year, 24-hour storm event?________ 

 

• What is the peak 100-year, 24-hour release rate from 
the proposed detention basin?__________ 

 

• Does the proposed detention basin meet the 
requirements of the WMO? ___________ 
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605.0 ft 

1.50 cfs 

YES 



RESERVOIR OUTLET STRUCTURES 
● Instead of specifying a 

stage-discharge 
relationship, HEC-HMS can 
calculate the outflow 
based on user-specified 
structure data 

 
● Under the Reservoir-1 tab, 

select Outflow Structures 
under Method 

 
● For the Initial Condition, 

assume Inflow = Outflow 
 
● Under Main Tailwater, 

select None 
 

● Under Outlets, specify “1” 
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RESERVOIR OUTLET STRUCTURES 
• Use the following restrictor 

information to enter the 
outlet structure in HEC-HMS: 
Diameter = 5.07 in 

Discharge Coefficient = 0.61 

Invert Elevation = 600.00 
 

• Once you’ve entered the 
outlet information, rerun the 
model for the 100-year, 24-
hour storm event.  

 

• How do the results compare 
to the previous simulation? 
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EXAMPLE PROBLEM #2 (INDIVIDUAL) 

Determine the required detention volume for 
the proposed development described below: 
• Total Project Area = 10 acres 

• Composite CN = 94, Reduced CN = 87.59 

• 75% Impervious Area 

• Time of Concentration = 15 minutes 

• Unrestricted Area = 0.3 acres 

• CN = 74 

• Time of Concentration = 10 minutes  

See Handout 
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EXAMPLE 2 – STEP 1 
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Step 1: Determine the required volume control storage 
for the site. 
 

The curve number for the site is 94, with a total 
impervious area of 7.5 acres (75%). The required 
volume control storage, Vc, for the site is calculated as: 
 

 

 

Vc = 1” x 
1 foot 

  x 7.5 acres = 0.63 acre-feet 
12 inches 



EXAMPLE 2 – STEP 2 
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Step 2: Determine the CN reduction corresponding to 
volume control calculated in Step 1. 
 

 
 

 

Using the CN Adjustment 
Calculator spreadsheet, the 
adjusted curve number is 
87.59 (it was assumed that 
only the required 1” of 
volume control storage 
would be provided). 
 



EXAMPLE 2 – STEP 3 
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Step 3A: Determine the 100-yr, 24-hr peak flow rate from 
the unrestricted area. 

 

 
 



GETTING STARTED  
THE INITIAL HEC-HMS SCREEN 

● Double-click on the HEC-HMS 
icon on your desktop 

 

 

 

● The following HEC-HMS 
Screen comes up:  
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HEC-HMS – SETTING UP A NEW PROJECT 

● Click on the “File” 
menu 
 

● From the drop 
down menu, select 
“New” 

 
● Name the new 

project “Example 2” 
 

● Be sure to set the 
Default Unit System 
to “U.S. Customary” 
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SETTING UP PROJECT DEFAULTS 
● Under the Tools Menu, 

go to Program Settings 
and go to the Defaults 
tab 

● Specify SCS Curve 
Number for Subbasin 
loss, SCS Unit 
Hydrograph for Subbasin 
transform, Modified Puls 
for Reach routing, and 
Specified Hyetograph for 
Subbasin precipitation 

● Then go to the Results 
tab and make sure that 
the values for elevation, 
volume, flowrate, and 
depth are taken to 2 
decimal places. 
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CREATING A BASIN MODEL 
● Under the Components 

tab, go to Basin Model 
Manager 

 

● Select “New” and name 
it “Basin 1” 
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ADDING BASIN MODEL COMPONENTS 
 

 

Subbasin: “Unrestricted” 
 

● Click on the Subbasin 
Creation Tool at the top 
of the screen to add a 
subbasin to the Basin 
Model. 

 

● Enter Subbasin Name as 
“Unrestricted”, and click 
at Create. 
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ENTERING SUBBASIN DATA 
● Click on Unrestricted 

and the data entry 
tabs will appear at the 
lower left corner 

 

● For Area, enter 
0.000469 mi2  

(0.3 acres) 
 

 

63 



ENTERING SUBBASIN DATA 
Continue … 
● Under the Loss tab, 

enter the reduced CN 
of 74 
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ENTERING SUBBASIN DATA 
Continue … 
● Under the Transform 

tab, enter the SCS Lag 
time of 6 minutes  

      (Lag time = 0.6 * Tc) 
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ENTERING RAINFALL DATA 
● In HEC-HMS, rainfall data is entered as a combination of Time-Series 

Data and the Meteorologic Model 

 

● The Time-Series Data reflects the rainfall distribution (Huff quartile 
distributions or actual rainfall records) 

 

● Time-Series Data cannot be entered in user-specified increments, 
interpolation of points on the Huff curves may be necessary for some 
storm events 

 

● The Meteorologic Model defines the rainfall depths and which 
subbasins those depths are applied  

 

66 



ENTERING TIME-SERIES DATA 
● From the Components 

menu, select Time-
Series Data Manager to 
create a new 
Precipitation Gage 
named “Huff3rd24hr” 
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ENTERING TIME-SERIES DATA 
Continue … 
● Under the Time-Series 

Gage tab, select Manual 
Entry, Cumulative 
Inches, and 1-hour 
increments 
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ENTERING TIME-SERIES DATA 

Continue … 
● Under the Time 

Window tab, run the 
storm from 
01Jan2000 through 
02Jan2000 (24-hour 
duration) 
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ENTERING TIME-SERIES DATA 
Continue … 
● Under the Table Tab, 

Enter the Huff 3rd 
Quartile Distribution for 
the 24-hour duration 
from the handout 
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ENTERING TIME-SERIES DATA 
Continue … 
● Use the Graph tab to 

see a plot of the 
distribution 
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CREATING THE METEOROLOGIC MODEL 
 

● From the Components 
tab, create a new 
Meteorologic Model 
named “100yr24hr” 
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CREATING THE METEOROLOGIC MODEL 

Continue … 
● Under the Meteorologic 

Model tab, make sure 
the Replace Missing is 
Set to Default 
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CREATING THE METEOROLOGIC MODEL 

Continue … 
● Under the Basins tab, 

select Yes under Include 
Subbasins? 
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CREATING THE METEOROLOGIC MODEL 

Continue … 
● Under the Options tab, 

select Yes for Total 
Override 
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CREATING THE METEOROLOGIC MODEL 

Continue … 
● Under the Specified 

Hyetograph tab, select 
the rainfall distribution 
that we previously 
created and enter the 
100-year, 24-hour 
rainfall depth. 
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CREATING THE CONTROL SPECIFICATIONS 

● We still need the specify 
how long to run the 
model for and how 
often we want to see 
output...this is 
performed under the 
Control Specifications 

 

● Under the Components 
menu, select Control 
Specifications Manager 
to create a new one 
named “100yr24hr” 
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CREATING THE CONTROL SPECIFICATIONS 

Continue … 
● Specify 01Jan2000 

through 03Jan2000 
(remember we’re 
running a 24-hour storm 
event) 

 

● Under Time Interval, 
specify 1 minute 
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CREATING THE SIMULATION RUN 
● A Simulation Run is a 

combination of: 
● Basin Model 
● Meteorologic Model 
● Control Specifications 

 
● To create a new Simulation 

Run, select Create 
Compute > Simulation Run 
under the Components 
menu 
 

● Name the run “100yr24hr” 
and click Next 

 
● Specify the Basin Model, 

Meteorologic Model, and 
Control Specifications that 
we’ve just created 
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RUNNING THE SIMULATION 
● Under the Compute 

menu, select Compute 
Run [100yr24hr] 

 

● All errors, warnings, and 
notes are shown in the 
lower right hand 
window 

 

● If there are errors, they 
will show up in red and 
the simulation will not 
run successfully 
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VIEWING RESULTS 
● If the Simulation Run 

was successful, right-
click on the components 
of the Basin Model to 
view individual results 

 

● Results are available as a 
Graph, Summary Table, 
or Time-Series Table 
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VIEWING RESULTS 

Continue… 
● To view the results for 

all model components at 
once, choose Global 
Summary Table under 
the Results Menu 
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EXAMPLE 2 – STEP 4 
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Determine Net Release Rate: 
The unrestricted 100-yr, 24-hr flowrate for the site = 0.19 cfs 

Net Release Rate = 0.3 cfs/acre X 10 acres – 0.19 cfs 

            = 2.81 cfs 
 

 
 



EXAMPLE 2 – STEP 5 
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Adding Basin Model Components 

• Subbasin-1 (Project Site) 

• Reservoir-1 (Detention Facility) 
 

 

 
 



ADDING BASIN MODEL COMPONENTS 
Subbasin: “Subbasin-1” 

 

● Click on the Subbasin 
Creation Tool at the top 
of the screen to add a 
subbasin to the Basin 
Model. 

 

● Enter Subbasin Name as 
“Subbasin-1”, and click at 
Create. 
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ADDING BASIN MODEL COMPONENTS 
Reservoir: “Reservoir-1” 

 

● Click on the Reservoir 
Creation Tool at the top 
of the screen to add a 
subbasin to the Basin 
Model. 

 

● Enter Reservoir Name as 
“Reservoir -1”, and click at 
Create. 
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ADDING BASIN MODEL COMPONENTS 
Connecting Subbasin-1 to Reservoir-1 

• To route the subbasin 
through the reservoir, 
right-click on the 
subbasin and select 
“Connect 
Downstream” and click 
on the reservoir. 
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ENTERING SUBBASIN DATA 
● Click on Subbasin-1 

and the data entry 
tabs will appear at the 
lower left corner 

 

● For Area, enter 
0.015156 mi2  

(9.7 acres) 
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ENTERING SUBBASIN DATA 
Continue… 
● Under the Loss tab, 

enter the reduced CN 
of 87.59 

 

89 



ENTERING SUBBASIN DATA 
Continue … 
● Under the Transform 

tab, enter the SCS Lag 
time of 9 minutes  

      (Lag time = 0.6 * Tc) 
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ENTERING RESERVOIR DATA 
● Click on Reservoir-1 and 

the data entry tabs will 
appear at the lower left 
corner 

 
● For Method, enter 

Outflow Curve 
 
● For Storage Method, 

select Elevation-Storage-
Discharge 

 
● Note that the Storage-

Discharge and Elevation-
Storage Functions are 
missing. This is the next 
step. 
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ENTERING RESERVOIR DATA 
● Using the spreadsheet available on the MWRD website, the 

following stage-discharge relationship was determined for the 
proposed detention basin: 
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Stage  
(ft) 

Discharge 
 (cfs) 

700 0.00 

701 1.09 

702 1.69 

703 2.13 

704 2.49 

705 2.81 



ENTERING RESERVOIR DATA 
● Using the spreadsheet available on the MWRD website, the 

following stage-storage relationship was determined for the 
proposed detention basin: 
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Stage  
(ft) 

Storage 
 (ac-ft) 

700 0.00 

701 0.47 

702 0.94 

703 1.41 

704 1.88 

705 2.35 



ENTERING RESERVOIR DATA 
● Under the Components 

tab, select Paired Data 
Manager 

 

● Add a new Storage-
Discharge. Enter Name 
as “Table_SD 1” 
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ENTERING RESERVOIR DATA 
 

● Under the Table tab, 
enter the appropriate 
Storage-Discharge 
values 
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ENTERING RESERVOIR DATA 
 

● Plots of the relationships 
are available under the 
Graph tab 
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ENTERING RESERVOIR DATA 
● Under the Components 

tab, select Paired Data 
Manager 

 

● Add a new Elevation-
Storage function. Enter 
Name as“Table_ES 1” 
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ENTERING RESERVOIR DATA 
 

● Under the Table tab, 
enter the appropriate 
elevation-storage values 
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ENTERING RESERVOIR DATA 
 

● Plots of the relationships 
are available under the 
Graph tab 
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RUNNING THE SIMULATION 
● Under the Compute 

menu, select Compute 
Run [100yr24hr] 

 

● All errors, warnings, and 
notes are shown in the 
lower right hand 
window 

 

● If there are errors, they 
will show up in red and 
the simulation will not 
run successfully 
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VIEWING RESULTS 
● If the Simulation Run 

was successful, right-
click on the components 
of the Basin Model to 
view individual results 

 

● Results are available as a 
Graph, Summary Table, 
or Time-Series Table 
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VIEWING RESULTS 
 

● To view the results for 
all model components at 
once, choose Global 
Summary Table under 
the Results Menu 
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EXAMPLE 2 RESULTS 
• What is the peak elevation in the proposed detention 

basin  for the 100-year, 24-hour storm event? 705 ft 

 

• What is the peak 100-year, 24-hour release rate from 
the proposed detention basin? 2.81 cfs 

 

• Does the proposed detention basin meet the 
requirements of the WMO? Yes 
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EXAMPLE PROBLEM #3 (INDIVIDUAL) 
Assuming there are 20 acres of offsite tributary area to the 
site in Example #2, determine the peak 100-year flowrate 
(on-site and off-site) that must be bypassed through the 
detention basin overflow weir.  
 

• Offsite Area = 20 Acres 

• CN = 81 

• Time of Concentration = 30 minutes 

 

Run the 100-year, 1-, 12-, and 24-storm events 
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Storm Event 
Peak Flowrate  

(cfs) 

100-Year, 1-Hour 

100-Year, 12-Hour 

100-Year, 24-Hour 



GETTING STARTED  
THE INITIAL HEC-HMS SCREEN 

● Double-click on the HEC-HMS 
icon on your desktop 

 

 

 

● The following HEC-HMS 
Screen comes up:  
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HEC-HMS – SETTING UP A NEW PROJECT 

● Click on the “File” 
menu 
 

● From the drop 
down menu, select 
“New” 

 
● Name the new 

project “Example 2” 
 

● Be sure to set the 
Default Unit System 
to “U.S. Customary” 
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SETTING UP PROJECT DEFAULTS 
● Under the Tools Menu, 

go to Program Settings 
and go to the Defaults 
tab 

● Specify SCS Curve 
Number for Subbasin 
loss, SCS Unit 
Hydrograph for Subbasin 
transform, Modified Puls 
for Reach routing, and 
Specified Hyetograph for 
Subbasin precipitation 

● Then go to the Results 
tab and make sure that 
the values for elevation, 
volume, flowrate, and 
depth are taken to 2 
decimal places. 
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CREATING A BASIN MODEL 
● Under the Components 

tab, go to Basin Model 
Manager 

 

● Select “New” and name 
it “Basin 1” 
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ADDING BASIN MODEL COMPONENTS 
 

 

Subbasin: “Subbasin 1” 
 

● Click on the Subbasin 
Creation Tool at the top 
of the screen to add a 
subbasin to the Basin 
Model. 

 

● Enter Subbasin Name as 
“Subbasin 1”, and click at 
Create. 
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ADDING BASIN MODEL COMPONENTS 
 

 

Subbasin: “Offsite” 
 

● Click on the Subbasin 
Creation Tool at the top 
of the screen to add a 
subbasin to the Basin 
Model. 

 

● Enter Subbasin Name as 
“Offsite”, and click at 
Create. 
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ADDING BASIN MODEL COMPONENTS 
 

 

Junction: “Junction 1” 
 

● Click on the Junction 
Creation Tool at the top 
of the screen to add a 
Junction to the Basin 
Model. 

 

● Enter Subbasin Name as 
“Junction 1”, and click at 
Create. 
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CONNECTING SUBBASIN-1 TO JUNCTION-1 
 

 

● Right-click on the 
subbasin-1 and select 
“Connect Downstream” 
and click on the Junction-
1. 
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CONNECTING OFFSITE TO JUNCTION-1 
 

 

● Right-click on the Offsite 
and select “Connect 
Downstream” and click 
on the Junctions. 
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ENTERING SUBBASIN DATA 
Subbasin-1 
● Click on Subbasin-1 

and the data entry 
tabs will appear at 
the lower left corner 

 

● For Area, enter 
0.015156 mi2  

(9.7 acres) 
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ENTERING SUBBASIN DATA 
Subbasin-1 

Continue … 
● Under the Loss tab, 

enter the reduced CN 
of 87.59 
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ENTERING SUBBASIN DATA 
Subbasin-1 

Continue … 
● Under the Transform 

tab, enter the SCS Lag 
time of 9 minutes  

      (Lag time = 0.6 * Tc) 
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ENTERING SUBBASIN DATA 
Offsite 

● Click on Offsite 
and the data 
entry tabs will 
appear at the 
lower left corner 

 

● For Area, enter 
0.03125 mi2  

(20.0 acres) 

 

 

117 



ENTERING SUBBASIN-1 DATA 
Offsite 

Continue … 
● Under the Loss tab, 

enter the reduced CN 
of 81 
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ENTERING SUBBASIN-1 DATA 
Offsite 

Continue … 
● Under the Transform 

tab, enter the SCS Lag 
time of 18 minutes  

      (Lag time = 0.6 * Tc) 
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ENTERING RAINFALL DATA 
● In HEC-HMS, rainfall data is entered as a combination of Time-Series 

Data and the Meteorologic Model 

 

● The Time-Series Data reflects the rainfall distribution (Huff quartile 
distributions or actual rainfall records) 

 

● Time-Series Data cannot be entered in user-specified increments, 
interpolation of points on the Huff curves may be necessary for some 
storm events 

 

● The Meteorologic Model defines the rainfall depths and which 
subbasins those depths are applied  
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ENTERING TIME-SERIES DATA 
● From the Components 

menu, select Time-
Series Data Manager to 
create a new 
Precipitation Gage 
named “Huff1st1hr” 
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ENTERING TIME-SERIES DATA 
Continue … 
● From Time-Series Data 

Manager dialog box  
click new and enter 
name as “Huff2nd12hr” 
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ENTERING TIME-SERIES DATA 
Continue … 
● From Time-Series Data 

Manager dialog box  
click new and enter 
name as “Huff3r24hr” 
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ENTERING TIME-SERIES DATA 
Continue … 
● Select Precipitation 

Gage “Huff1st1hr” 

● Under the Time-Series 
Gage tab, select Manual 
Entry, Cumulative 
Inches, and 6-minute  
increments 
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ENTERING TIME-SERIES DATA 

Continue … 
● Under the Time 

Window tab, run the 
storm from 
01Jan2000 00:00 
through 01Jan2000 
01:00 (1-hour 
duration) 
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ENTERING TIME-SERIES DATA 
Continue … 
● Under the Table Tab, 

Enter the Huff 1st 
Quartile Distribution for 
the 1-hour duration 
from the handout 
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ENTERING TIME-SERIES DATA 
Continue … 
● Use the Graph tab to 

see a plot of the 
distribution 
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ENTERING TIME-SERIES DATA 
Continue … 
● Select Precipitation 

Gage “Huff2nd12hr” 

● Under the Time-Series 
Gage tab, select Manual 
Entry, Cumulative 
Inches, and 30 minute  
increments 
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ENTERING TIME-SERIES DATA 

Continue … 
● Under the Time 

Window tab, run the 
storm from 
01Jan2000 00:00 
through 01Jan2000 
12:00 (12-hour 
duration) 
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ENTERING TIME-SERIES DATA 
Continue … 
● Under the Table Tab, 

Enter the Huff 2nd  
Quartile Distribution for 
the 12-hour duration 
from the handout 
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ENTERING TIME-SERIES DATA 
Continue … 
● Use the Graph tab to 

see a plot of the 
distribution 
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ENTERING TIME-SERIES DATA 
Continue … 
● Select Precipitation 

Gage “Huff3rd24hr” 

● Under the Time-Series 
Gage tab, select Manual 
Entry, Cumulative 
Inches, and 1 hour 
minute  increments 
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ENTERING TIME-SERIES DATA 

Continue … 
● Under the Time 

Window tab, run the 
storm from 
01Jan2000 00:00 
through 02Jan2000 
00:00 (24-hour 
duration) 
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ENTERING TIME-SERIES DATA 
Continue … 
● Under the Table Tab, 

Enter the Huff 3rd  
Quartile Distribution for 
the 24-hour duration 
from the handout 
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ENTERING TIME-SERIES DATA 
Continue … 
● Use the Graph tab to 

see a plot of the 
distribution 
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CREATING THE METEOROLOGIC MODEL 
 

STORM EVENT: 
100YR,1HR 
● From the Components 

tab, create a new 
Meteorologic Model 
named “100yr1hr” 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,1HR 

Continue … 
● Under the Meteorologic 

Model tab, make sure 
the Replace Missing is 
Set to Default 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,1HR 

Continue … 
● Under the Basins tab, 

select Yes under Include 
Subbasins? 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,1HR 

Continue … 
● Under the Options tab, 

select Yes for Total 
Override 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,1HR 

Continue … 
● Under the Specified 

Hyetograph tab, select 
the rainfall distribution 
that we previously 
created and enter the 
100-year, 1-hour 
rainfall depth. 
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CREATING THE METEOROLOGIC MODEL 
 

STORM EVENT: 
100YR,12HR 
● From the Components 

tab, create a new 
Meteorologic Model 
named “100yr12hr” 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,12HR 

Continue … 
● Under the Meteorologic 

Model tab, make sure 
the Replace Missing is 
Set to Default 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,12HR 

Continue … 
● Under the Basins tab, 

select Yes under Include 
Subbasins? 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,12HR 

Continue … 
● Under the Options tab, 

select Yes for Total 
Override 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,12HR 

Continue … 
● Under the Specified 

Hyetograph tab, select 
the rainfall distribution 
that we previously 
created and enter the 
100-year, 1-hour 
rainfall depth. 
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CREATING THE METEOROLOGIC MODEL 
 

STORM EVENT: 
100YR,24HR 
● From the Components 

tab, create a new 
Meteorologic Model 
named “100yr12hr” 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,24HR 

Continue … 
● Under the Meteorologic 

Model tab, make sure 
the Replace Missing is 
Set to Default 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,24HR 

Continue … 
● Under the Basins tab, 

select Yes under Include 
Subbasins? 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,24HR 

Continue … 
● Under the Options tab, 

select Yes for Total 
Override 
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CREATING THE METEOROLOGIC MODEL 
STORM EVENT: 
100YR,24HR 

Continue … 
● Under the Specified 

Hyetograph tab, select 
the rainfall distribution 
that we previously 
created and enter the 
100-year, 1-hour 
rainfall depth. 
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CREATING THE CONTROL SPECIFICATIONS 

100yr,1hr 

● We still need the specify 
how long to run the 
model for and how 
often we want to see 
output...this is 
performed under the 
Control Specifications 

 

● Under the Components 
menu, select Control 
Specifications Manager 
to create a new one 
named “100yr1hr” 
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CREATING THE CONTROL SPECIFICATIONS 

100yr,1hr 

Continue … 
● Specify 01Jan2000 

through 02Jan2000 

● Under Time Interval, 
specify 3 minute 
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CREATING THE SIMULATION RUN 
100yr,1hr 
● A Simulation Run is a 

combination of: 
● Basin Model 
● Meteorologic Model 
● Control Specifications 

 
● To create a new Simulation 

Run, select Create 
Compute > Simulation Run 
under the Components 
menu 
 

● Name the run “100yr1hr” 
and click Next 

 
● Specify the Basin Model, 

Meteorologic Model, and 
Control Specifications that 
we’ve just created for 
100yr1hr storm event 
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RUNNING THE SIMULATION 
100yr,1hr 
● Under the Compute 

menu, select Compute 
Run [100yr1hr] 

 

● All errors, warnings, and 
notes are shown in the 
lower right hand 
window 

 

● If there are errors, they 
will show up in red and 
the simulation will not 
run successfully 
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CREATING THE CONTROL SPECIFICATIONS 

100-yr, 12-hr 

● Under the Components 
menu, select Control 
Specifications Manager 
to create a new one 
named “100yr12hr” 
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CREATING THE CONTROL SPECIFICATIONS 

Continue … 
● Specify 01Jan2000 

through 02Jan2000 

● Under Time Interval, 
specify 3 minute 

 

 

156 



CREATING THE SIMULATION RUN 
100-yr, 12-hr 
● A Simulation Run is a 

combination of: 
● Basin Model 
● Meteorologic Model 
● Control Specifications 

 
● To create a new Simulation 

Run, select Create 
Compute > Simulation Run 
under the Components 
menu 
 

● Name the run “100yr12hr” 
and click Next 

 
● Specify the Basin Model, 

Meteorologic Model, and 
Control Specifications that 
we’ve just created for 
100yr12hr storm event 
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RUNNING THE SIMULATION 
100-yr, 12-hr 

● Under the Compute 
menu, select Compute 
Run [100yr12hr] 

 

● All errors, warnings, and 
notes are shown in the 
lower right hand 
window 

 

● If there are errors, they 
will show up in red and 
the simulation will not 
run successfully 
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CREATING THE CONTROL SPECIFICATIONS 

100-yr, 24-hr 

● Under the Components 
menu, select Control 
Specifications Manager 
to create a new one 
named “100yr24hr” 
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CREATING THE CONTROL SPECIFICATIONS 

100-yr, 24-hr 

Continue … 
● Specify 01Jan2000 

through 02Jan2000 

● Under Time Interval, 
specify 3 minute 
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CREATING THE SIMULATION RUN 
100-yr, 24-hr 
 
● A Simulation Run is a 

combination of: 
● Basin Model 
● Meteorologic Model 
● Control Specifications 

 
● To create a new Simulation 

Run, select Create Compute 
> Simulation Run under the 
Components menu 
 

● Name the run “100yr24hr” 
and click Next 

 
● Specify the Basin Model, 

Meteorologic Model, and 
Control Specifications that 
we’ve just created for 
100yr24hr storm event 
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RUNNING THE SIMULATION 
100-yr, 24-hr 
● Under the Compute 

menu, select Compute 
Run [100yr24hr] 

 

● All errors, warnings, and 
notes are shown in the 
lower right hand 
window 

 

● If there are errors, they 
will show up in red and 
the simulation will not 
run successfully 
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VIEWING RESULTS 
100-yr, 1-hr 
● If the Simulation Run 

was successful, right-
click on the components 
of the Basin Model to 
view individual results 

 

● Results are available as a 
Graph, Summary Table, 
or Time-Series Table, 
under Result Tab. 

 

 

 

163 



VIEWING RESULTS 
100-yr, 12-hr 
● If the Simulation Run 

was successful, right-
click on the components 
of the Basin Model to 
view individual results 

 

● Results are available as a 
Graph, Summary Table, 
or Time-Series Table, 
under Result Tab. 
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VIEWING RESULTS 
100-yr, 24-hr 
● If the Simulation Run 

was successful, right-
click on the components 
of the Basin Model to 
view individual results 

 

● Results are available as a 
Graph, Summary Table, 
or Time-Series Table, 
under Result Tab. 
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VIEWING RESULTS (GLOBAL SUMMARY) 

100-yr, 1-hr 
● To view the results for 

all model components at 
once, choose Global 
Summary Table under 
the Results Menu 
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VIEWING RESULTS (GLOBAL SUMMARY) 

100-yr, 12-hr 
● To view the results for 

all model components at 
once, choose Global 
Summary Table under 
the Results Menu 
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VIEWING RESULTS (GLOBAL SUMMARY) 

100-yr, 24-hr 
● To view the results for 

all model components at 
once, choose Global 
Summary Table under 
the Results Menu 

 

 

168 



EXAMPLE 3 RESULTS 
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Storm Event 
Peak Flowrate  

(cfs) 

100-Year, 1-Hour 73 

100-Year, 12-Hour 31 

100-Year, 24-Hour 21 


